
F.0
Firmware Upload Tool and Device Software Upgrade and Installation 
and Guide

1.0 Introduction

This document provides the user information related to the installation and usage of the FWUT (Firmware 
Upgrade Tool). FWUT is used for upgrading the firmware on the RTS-OMNEO devices. FWUT supports 
firmware upgrade for the following RTS-OMNEO devices.

2.0 Overview

The updating process consists of five steps:

1. Download the OMNEO Suite from the RTS website
2. Run the Setup file (“Installation Steps” on page 5)
3. Verify IPedit and AZedit are on the PC being used for the upgrade
4. Run FWUT (“Example of Upgrade Steps” on page 12).
5. Verify the installation of the firmware is successful using IPedit or AZedit

Nr. Device Description Displayed in FWUT

1 OMI OMNEO Matrix Interface card. OMI Tab

2 OKI
OMNEO Keypanel Interface card. This is the option 
interface card used with KP-32 CLD, KP-12 CLD, KP-
32 Classic and RP-1000.

OKI Tab

3 OEI-2
OMNEO External Interface box. This box is used to 
provide an OMNEO interface to legacy keypanels.

OEI-2 Tab

4 OKP
The new KP Series keypanels with a built-in OMNEO 
interface. This includes all KP Series models.

OKP Tab

5 OAP

Upcoming Access Point devices used with ROAMEO 
beltpacks (BP) 

NOTE: The ROAMEO beltpack firmware is not 
supported by FWUT. However, the 
beltpack firmware can be uploaded via the 
USB port on the beltpack.

OAP Tab

6 ARNI

Audio Routed Network Interface

ARNI-S (standard)

ARNI-E (enterprise)

ARNI-E/S
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3.0 FWUT Information

IMPORTANT: Verify the FWUT and the device upgrade files are installed on the PC or laptop before upgrading 
the firmware to the RTS-OMNEO devices. 

3.1 Installation Files 

The FWUT and the device upgrade files are available with the OMNEO Suite in the following folder at 
\OMNEOSuite<V.x.x>\Packages\. 

The FWUT folder contains installation files for both 64- and 32-bit systems. Appropriate setup files 
must be chosen for installation.

Use Table 1 to determine the proper setup files needed to upgrade the RTS-OMNEO devices.

3.1.1 Installation Folder

The FWUT setup files are installed under the following folder on the PC/Laptop:

C:\Program Files\BOSCH\OMNEO\Firmware Upload Tool

The following sub-folder contains the FWUT files related to the devices (OMI, OKI, OEI-2,
KP Series…):

C:\Program Files\BOSCH\OMNEO\Firmware Upload Tool\Upload Plugins 

TABLE 1. Setup Files

Nr. File Namea

a. The f ile names for a 32-bit system.

Description

1 SetupOMNEOFirmwareUploadTool64.msi This setup installs the FWUT tool utility.

2 SetupOMNEONiosFirmware64.msi
This setup installs files required for OMI firmware 
upgrade.

3 SetupOMNEOOEI2Firmware64.msi
This setup installs files required for OEI-2 firmware 
upgrade.

4 SetupOMNEOOKPFirmware64.msi
This setup installs files required for KP Series 
firmware upgrade.

5
SetupOMNEOOAPFirmware64.msi
(currently unavailable)

This setup installs files required for Access Point 
firmware upgrade.

6 SetupOMNEOArniFirmware64.msi
This setup installs files required for ARNI firmware 
upgrade.

7 SetupBoschDNS-SDService64.msi
This setup installs files required for 
Bosch DNS-SD service used for discovery of devices 
in the FWUT.
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3.1.2 Installation Steps

There are two options for installing the setup files:

Option 1 (Recommended) Run the Setup.exe in the OMNEO Suite package. 
The OMNEO Setup (OCA) window appears.

IMPORTANT: When the OMNEO Suite is installed, the main application plus all plug-ins installed 
automatically.

Option 2 Manually install the individual setup files.

3.1.3 FWUT Usage

A help file, named FirmwareUploadTool.chm, is installed along with the FWUT file. It contains 
information on the FWUT and its usage. It also has instructions on how to complete some of the 
more necessary operational procedures, such as how to run the FWUT in advanced mode from a 
command line.
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3.2 Firmware Upgrade

When the FWUT is launched, it automatically displays all the RTS-OMNEO devices discovered in the 
system. The devices are listed on the separate tabs based on the Model ID. Use Table 2 to determine the 
Model ID of the RTS-OMNEO devices and their user-identifiable names. For more information, see 
“Example of Upgrade Steps” on page 12.

TABLE 2. Model ID Description

Nr. Model ID As displayed on FWUT 
Tab Description

1 2049 OMI-Audio Device OMI-Audio Device

2 2050 OKI OKI

3 2051 OMI-Controller OMI-Controller Device

6 2060 OEI-2 OEI-2

7 2070 OKP KP Series (OMNEO keypanel)

8 2080 OAP OMNEO Access Point
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3.2.1 Firmware Upgrade Files

NOTE: FWUT only recognizes and supports files which have a .capfw extension. No other file 
formats (mot, bin, hex) are supported. 

Each device has set of .capfw files used for upgrading the firmware. 
The naming convention <DeviceName_Firmware_Version>.capfw is used in naming the files.

Table 3 displays the currently released .capfw files for RTS-OMNEO devices. For more 
information, see the individual device’s release notes.

IMPORTANT: The selection of RSTP or noRSTP .capfw firmware file is determined by the network 
configuration. For more information, see the OMNEO Resource Guide available on the RTS 
website.

NOTE: Refer to the KP Series release notes in case there is a change in the client or FPGA 
image.

TABLE 3. Firmware Files

# Device Firmware Files Description

1 OMI

OMI-Firmware_RSTP_V6.x.x.capfw
OMI-Firmware_noRSTP_V6.x.x.capfw

Firmware files which upgrade 
the OMI card

OMI-Firmware_FPGA_0.75.capfw
Firmware files which upgrade 
the FPGA on the OMI card

2 OKI
OKI-Firmware_RSTP_V6.x.x.capfw
OKI-Firmware_noRSTP_V6.x.x.capfw

Firmware files which upgrade 
the OKI card

3 OEI-2
OEI-Firmware_RSTP_V6.x.x.capfw
OEI-Firmware_noRSTP_V6.x.x.capfw

Firmware files which upgrade 
the OEI-2 card

The following files give details for the different OKP (KP Series) firmware file. Each firmware file is 
used to update a particular component. This is to provide flexibility when there is only one component 
to update.

4A OKP_Audinate_v5.xx.yyyy_Client_v2.xx-OCA.capfw
RSTP version of firmware 
and should be used to update 
all the KP Series components

4B
OKP_Audinate_NoRSTP_v5.xx.yyyy_Client_v2.xx-
OCA.capfw

Non-RSTP version of 
firmware and should be used 
to update all the KP Series 
components

4C OKP FPGA v5.0.0.capfw
This firmware file contains 
the Intercom FPGA 
component
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AZedit Upgrade (Optional)

This section is specifically for the KP Series keypanels. Table 4 gives details about 
the files that can be upgraded via AZedit tool.

NOTE: It is recommended to run the most current version of the bootloader. The 
keypanel must be connected to Intercom via either an OMI card or an AIO 
card.

TABLE 4. Firmware Upgrades

# Filename Description

1 KP-Series_client_z_v2.x.x-OCA.mot
This file updates the client component of the K
keypanels. It does not contain the Dante comp

2 KP-Series-FPGA_v5.0.0.mot
This file contains the Intercom FPGA compon
the KP Series keypanels. This is not Dante com

3 KP-Series_boot_v1.3.0.mota

a. To check versions on the device, press and hold both shaft encoders and then press the Menu button on the
Service menu appears.
Select Boot Code.
The Boot Code version appears on the panel display.

This is the firmware file for the boot loader of
keypanels. 
The boot loader component cannot be updated
the FWUT.

4 VM-chimes.mot This file contains the default voice mail chime

5 VM-icons.mot This file contains the default voice mail icons.



4.0 Migration from OCP to OCA

Beginning with V6.x.x, all RTS-OMNEO device firmware has been migrated to the new OCA Platform. 
Previous versions up to and including V5.2.12 have been discontinued. 

V6.x.x provides following features

• Adjustable Receiver Latency
• Switch between RSTP/no RSTP mode from IPedit
• Show audio connection status in IPedit between RTS-OMNEO devices and other Dante devices

IMPORTANT: These instructions need to be followed exactly for a successful migration of the RTS-OMNEO 
devices. Refer to the release notes provided in the OMNEOSuiteV6.x.x for details.

All devices in the system must be updated for devices to work with each other. OCA devices 
cannot be used with non-OCA devices. 

4.1 Mandatory Instruction

IMPORTANT: It is crucial to uninstall the existing FWUT package and reinstall the update.

1. Uninstall the existing version of the FWUT and its associated plug-ins.

a. From the Start Menu, select Control Panel | Programs.

b. Click Uninstall a program.

c. Uninstall the OMNEO FWUT, NIOS, OEI2, and OKP Firmware packages. 
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d. Verify the following directories are present and that they are empty. If there are files in the 
directory, then delete them.

• C:\Program Files\Bosch\OMNEO\Firmware Upload Tool
• C:\Program Files\Bosch\OMNEO\Firmware Upload Tool\UploadPlugins

2. Using the latest version provided in the OMNEO Suite V6.1.x or higher, upgrade the FWUT and the 
associated plug-ins.

NOTE: For the latest version of the OMNEO Suite, visit www.rtsintercoms.com.

3. Verify files are present in the following directories:

a. C:\Program Files\Bosch\OMNEO\Firmware Upload Tool 
• OAPOCAFWUTProxy.dll 
• FpgaNiosFWUProxy.dll 
• MCUFWUTProxy.dll 

b. C:\Program Files\Bosch\OMNEO\Firmware Upload Tool\UploadPlugins
• UploadFpgaNIOS.dll 
• UploadOKP.dll 
• UploadOEI2.dll 

4. Using the following graphics, determine the correct migration sequence and .capfw file to use. 

IMPORTANT: To avoid firmware upgrade failures and incorrect firmware being installed on the devices, use the 
illustration below lists the path for different devices.
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The following migration path determines the firmware files required for the KP Series panels.
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4.2 Example of Upgrade Steps

The following example shows upgrading OMI device, but this example is applicable for other device 
types.

1. Open the FWUT.

Once the FWUT is opened it displays a list of devices (shown). If this displays, it means the image 
folder path does not contain the firmware upgrade files (.capfw files).

2. From the File menu, select Options.
The Firmware Upload Tool Options window appears.

3. Enter the image folder path which contain the .capfw file.
OR
Click the Change button to navigate to the file.
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In this example the image path contains folder which has OMI .capfw files.

Once the image folder path is set the FWUT displays the OMI tab which contains the discovered 
OMI devices (shown).

4. From the OMI tab page, select the OMI device or devices.
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5. Click the Upload button.
The Select Firmware for upload window appears displaying a list of OMI .capfw files.

6. From the Available firmware list, select the correct OMI .capfw file.
The Start button activates.
14



7. Click the Start button.
A progression bar displays showing the progress of the firmware upgrade.

The version string for IO card in AZedit alternates between version and Firmware Download In 
Progress (shown).

The State column displays Finished.

8. Verify the version is updated in AZedit or IPedit. 
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5.0 Troubleshooting Guide

Q1. I see the device discovered in the FWUT, but when I select the file and click update, it displays Failed 
immediately.

A1. Verify the IP Address of the PC/Laptop running FWUT is in the same subnet as the devices being 
upgraded. Even though FWUT can discover devices in other subnets, it will fail to connect.

A2. Verify the correct adapter is selected when the FWUT is launched.

A3. Verify two IP Addresses have not been assigned to the same adapter.

Q2. FWUT is in the same subnet as the devices, but when I select the file and click update, nothing happens.

A2. Verify the device upgrade files have been installed for that device. 
These files are available in the following directory:
 C:\Program Files\BOSCH\OMNEO\Firmware Upload Tool\UploadPlugins
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Q3. How do I refresh the FWUT so it shows the updated status?

A3. From the File menu, select Options, and then click OK.

The Options window appears.
Click OK.
The Options window closes.

Q4. How do I abort a Firmware upgrade to a device from the FWUT?

A4. The FWUT does not have an Abort button. Use the Windows Task Manager to force the Firmware 
Upload Tool to close.

NOTE: All devices have a fail-safe mechanism implemented in them.

Q5. I see the device in the FWUT, but when I select the file and click update, it displays a green progress bar, 
but then shows Failed after some time.

A5. Verify the TFTP ports / application are blocked on the network or by the firewall. 
FWUT uses TFTP to transfer files to the devices. 

Q6. How do I get additional information on why the upgrade to the device failed?

A6. FWUT log files are available in two places:

1. From the View menu, select Logging. 
The Logging window appears and displays the currently logged messages. The log messages in this 
window are lost when FWUT is closed.
OR
Navigate in Windows Explorer to C:\ProgramData\Bosch\OMNEO\FirmwareUploadLog. 
This folder contains log file. A new log file is created every time FWUT is opened. For trouble-
shooting the information in the log file is helpful. 
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Q7.What is advanced mode of the FWUT?

A7. Advanced mode of the FWUT is exactly same as the normal mode as far as the upgrade process is 
concerned. In Advanced Mode, additional menu items are displayed. For more information, see the 
FWUT help file.

Q8. How do I run the advanced mode of the FWUT?

A8. Open the DOS CMD Prompt window. 
Go to the directory (shown). 
Type in the command FirmwareUploadGUI.exe /advanced true.
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Q9. Why do I see numbers like 2050, 2049, and 2070 on the FWUT Tabs instead of the OKI, OMI, and OKP?

A9. FWUT discovers devices using Bosch DNS-SD service. The discovered devices and their names are 
displayed as Model ID’s of the devices. For more information on Model ID, see Table 2 on page 6.The 
user defined names are displayed based on the firmware upgrade .capfw files. The .capfw files should be 
present as defined in the following path. 

1. Click File | Options
The Firmware Upload Tool Options window appears.

Q10. What happens if the Firmware Upgrade process is interrupted because of one of the following two 
conditions? 

• Network Disconnection
• Accidental shutdown of devices

A10. All RTS-OMNEO devices implement a fail-safe mechanism. After timeout, the FWUT displays a Failed 
status. The devices themselves reset and reboot to the previous version or if they are in the boot loader 
mode, they stay in the boot loader mode. The recovery options are shut down  the FWUT and reopen it, 
so that the devices are discovered again. Send the upgrade files again.

Q11. What is OMI-Controller and OMI-Audio Device? How do I upgrade them?

A11. The OMI IO card has two upgradable components – OMI-Controller and OMI-Audio Device. These 
components have different roles and communicate internally with each other over the SPI bus. 
The OMI-Controller manages the Intercom functionality and audio routes. 
The OMI-Audio manages all the audio.
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Q12. The OMI-Controller version is different from the Audio device version, how do I sync it?

A12. The simplest way is upgrade/downgrade the Audio Device version to that of the OMI-Controller. The 
steps to do this is as follows. 

1. Open the FWUT.
2. From the File menu, select Options and then select the image folder path which contains only the 

OMI_AudioDevice<version>.cap.
3. Click OK.

The OMI-Audio Device tab appears.
4. Select the OMI device for which there is a mismatch.
5. Click the Upgrade button.
6. Click the Send button.

Once the upgrade is successfully completed, both versions are synced.

Q13.I have selected OMI-Firmware .capfw, the controller is showing new version on AZEdit/IPEdit but the 
FWUT stills shows updating?

A13. As mentioned earlier OMI has 2 components OMI-Controller and OMI-Audio Device, the FWUT 
upgrades the OMI-Controller first. Once the OMI-Controller is updated, the OMI card resets. The FWUT 
reconnects with the OMI card and then starts the upgrade of the OMI-Audio Device. Till the OMI-Audio 
device upgrade is not completed the FWUT will show as updating.

Q14. I have selected OMI-Firmware.capfw, the upgrade was successful but only Audio Device got updated 
and not the OMI-Controller?

A14. The primary reason for this is the SetupOMNEONiosFirmware64.msi is not installed. Verify the OMI 
Plug-in files are correctly installed. For more information, see “Firmware Upgrade Files” on page 7.
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Q15. I have installed all the FWUT packages correctly, still I do not see any devices

A15. Check if the Bosch DNS-SD service is installed. If installed, is it running? 

To verify the Bosch DNS-SD, do the following:

1. Verify the Bosch DNS-SD  files are available in the folder: C:\Program Files\BOSCH\DNS-SD.
2. Verify the Bosch DNS-SD service status is displayed as Started.

Q16: The OMI card Version string shows Hardware Failure? Is the OMI card not working?

A16: No, this means that OMI-Controller is not able to communicate with the OMI-Audio Device. This could 
be because of Version Mismatch, mismatch of IP address of OMI-Controller and OMI-Audio Device.
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